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Artemis ⽴ち上げの前に
【注意事項】全⾓⽂字は避けてください！
コンピュータのアカウント名に全⾓の⽂字（例：⼤渕、オオフチ）
が⼊っているとAthenaからのデータインポートやフィッティング
が実⾏できない可能性があります。OSのバージョンによっては、
コンピュータ名が全⾓⽂字でもNGです。
*Artemisは C:¥Users¥アカウント名¥Desktop のパスを経由して各フォルダにアクセスするようです。

その場合は、半⾓の名称で別のアカウントを作って下さい。
データを格納するフォルダも半⾓の名称で作って下さい。

Artemisには未知のバグが多数存在するため、こまめに保存する
ことをおすすめします。



概要

1. EXAFS解析の流れ
2. Artemisを使⽤した解析

構造モデルの作成
理論計算結果の⽐較
カーブフィッティング



EXAFS解析の流れ
Artemis⽴ち上げ

① Athenaデータ読み込み

② 構造モデルの作成(Atoms)
モデル作成に必要な情報
・吸収元素の種類、吸収端
・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）
・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実⾏

⑥ 束縛条件下でのフィッティング

Athenaでデータ処理しておく！
・Background、Baselineの処理
・(k)(EXAFS振動)の抽出
・(k)をFT-EXAFSに変換

Atoms: FEFFの実⾏ファイルを
作成するためのプロフラム

.cif ファイルを⼊⼿しておくと
モデル作成の⼿間が幾分省ける

FEFF: 光電⼦の散乱過程と
散乱強度を計算するための

プログラム

⑦ 解析結果の保存



Help > About Artemis から
バージョンを確認できる

*最新版は 0.9.26 です
(2018年8⽉1⽇現在)

Artemis ⽴ち上げ

Data sets Addボタン
Athenaデータ（実験
データ）を読み込む

Feff calculations Addボタン
.cif ファイルを読み込むのに使う

（今回は使いません）

プロットオプションウィンドウ
基本的な使い⽅は Athena と同じ



Artemis 保存の⽅法

File > Save project as

Save ボタンでも
保存できる
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① Athenaデータ読み込み
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・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）
・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実⾏

⑥ モデル妥当性の検証

Athenaでデータ処理しておく！
・Background、Baselineの処理
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散乱強度を計算するための

プログラム

⑦ 解析結果の保存



① Athenaデータ読み込み

File > Open project or data
or 
Ctrl + o
or 
Data sets Add ボタン

ZnO.prj を選択 > 開く

ZnO.txt を選択 > Import 
selected data

*Add ボタン上で右クリックすると、最近開いたAthenaのプ
ロジェクトファイル⼀覧が表⽰され、そこからAthenaのデー
タを読み出すこともできる

*ここはデフォルトでOK



① Athenaデータ読み込み
データウィンドウとプロットウィンドウが新たに⽴ち上る

Data sets に ZnO.txt が追加される

*左クリックするとデータウィンドウが最⼩化する

*右クリックで名称変更(rename)、削除(discard)ができる



① Athenaデータ読み込み
データウィンドウ詳細

フーリエ変換する範囲
kmaxを14.5に変更

逆フーリエ変換（フィッ
ティング）する範囲

kn.(k) (n = 1,2,3)のうち、
どのデータをフィットする
のかを選択（複数選択可）

k123: kn.(k) (n = 1,2,3)をプロット
R123: k123をフーリエ変換したものをプロット
Rmr: Rと虚数部をプロット
Rk: Rとkをプロット
kq: kとq(逆フーリエ変換)をプロット

Include in fit: ZnO.txtのデー
タをフィッティングする
（☑） or しない（□）
Plot after fit: フィット後、
プロットウィンドウに結果を
表⽰する（☑） or しない
（□）
Fit background:
Plot with phase correction:
これら2つのオプションの詳
細はDemeterのWebページを
参照して下さい
通常はチェックを外しておく



プロットウィンドウ

① Athenaデータ読み込み

kの重み付けを指定
3に変更

k空間を表⽰

R空間を表⽰

プロットするデータの
種類を指定

横軸のスケールを指定
kmaxを20に変更

Clear: Plotting listを
クリアする

Save next plot to a file:
このボタンを押して、上部にある
k,R,qのボタンを押すと保存先を指
定するウィンドウが出現し、該当す
るプロットが.txtで保存できる

プロットするデータを選択
複数選択可）
右クリックでdiscardを選ぶと
listから削除



よくやってしまう操作ミス
(A) データウィンドウを × で消してしまった
(B) プロットウィンドウを × で消してしまった
(C) Plotting list からデータを消してしまった
(D) Clear ボタンを押して、Plotting list が真っ⽩になった

安⼼してください！ 復旧できますよ！

(A) データウィンドウを × で消しても、最⼩化されているだけなので、
Showボタンから復帰できます

① Athenaデータ読み込み



よくやってしまう操作ミス
(A) データウィンドウを × で消してしまった
(B) プロットウィンドウを × で消してしまった
(C) Plotting list からデータを消してしまった
(D) Clear ボタンを押して、Plotting list が真っ⽩になった

安⼼してください！ 復旧できますよ！

(B) プロットオプションウィンドウのk, R, qのいずれかを押すと
プロットウィンドウが復活します

① Athenaデータ読み込み



よくやってしまう操作ミス
(A) データウィンドウを × で消してしまった
(B) プロットウィンドウを × で消してしまった
(C) Plotting list からデータを消してしまった
(D) Clear ボタンを押して、Plotting list が真っ⽩になった

安⼼してください！ 復旧できますよ！

(C,D) データウィンドウのこのボタンを押すと、該当するデータが
Plotting listに追加されます

① Athenaデータ読み込み



EXAFS解析の流れ
Artemis⽴ち上げ

① Athenaデータ読み込み

② 構造モデルの作成(Atoms)
モデル作成に必要な情報
・吸収元素の種類、吸収端
・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）
・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実⾏

⑥ モデル妥当性の検証

Athenaでデータ処理しておく！
・Background、Baselineの処理
・(k)(EXAFS振動)の抽出
・(k)をFT-EXAFSに変換

Atoms: FEFFの実⾏ファイルを
作成するためのプロフラム

.cif ファイルを⼊⼿しておくと
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② 構造モデルの作成
Feff calculations  Addボタン

右クリック

[---] Open a blank Atoms window
を選択 > OK

Atoms のウィンドウが⽴ち上る

*.cif ファイルを持っている場合は、左クリック
から、該当する .cif ファイルを選択して読み込
ませる。



② 構造モデルの作成
Atomsウィンドウ詳細
.cif ファイルを持っていれば、
ここから読み込むことも可能

結晶構造情報を⼊⼒する
ZnOの結晶構造情報
空間群 P63mc (186)
原⼦座標

Zn: 1/3, 2/3, 0
O: 1/3, 2/3, 0.3917

格⼦定数
a = 3.2501 Å
b = 3.2501 Å
c = 5.2071 Å
α = 90°
β = 90 °
γ = 120 °

*2つ以上のサイトを同じ元素が占有している構造に対し
て⽤いると、平均のEXAFSを計算する。
例：3種類のTiサイトを有するBaTi2O5など



② 構造モデルの作成
⼊⼒例：ZnO

名称（実質何でもよい）

XAFSのデータは、ZnのK-edge

FEFFで計算するモデルの⼤きさ
（Znを原点とする球の直径）

光電⼦が散乱される最⼤の距離
（≒最⻑の結合距離）
⼊⼒値より⻑い距離は計算しない

186 でもよい

*部分置換モデルには、今のところ対応していない。

置換量が微量の場合は、ちょっとした⼯夫で対応が可能。
（例：GaNに添加した微量EuのEu LIII-edge EXAFS）



② 構造モデルの保存
⼊⼒後、保存ボタン（フロッピーのマーク）で、この構造モデルを保存してください。
保存名：ZnO.inp

⼀度、.inp として構造モデルを保存しておけば、
次回からは、Open file ボタンで読み出すことができる。
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③ EXAFSの理論計算

Run Atoms
FEFFに読み込ませるため
のファイルを作成する
左クリックで実⾏

タブがFeffに切り替わり、Feff
input file が作成される

Run Feff
FEFFによるEXAFSの理論
計算を実⾏する（左ク
リック）

吸収原⼦
散乱原⼦

吸収端を指定する
K:  HOLE 1      
LI: HOLE 2     
LII: HOLE 3   
LIII: HOLE 4

座標 元素種 中⼼からの距離

*書式の詳細についてはFEFFのWebペー
ジを参照してください
http://monalisa.phys.washington.edu/
feffproject-feff-documentation.html



③ EXAFSの理論計算

Feff input file を必要に応じて保存する。
Atoms と同様に Save file ボタンで保存できるが、
Atoms と 同じ拡張⼦（.inp）なので、別名で保存する必要がある。
例）feff-ZnO.inp



EXAFS 計算結果の⾒⽅

③ EXAFSの理論計算

Degen
多重度（＝配位数）

Reff
結合距離

Scattering path
光電⼦の散乱過程を表⽰する
@が吸収元素

Rank
EXAFS振動への寄与
（最も強いpathを100としている）

Type
光電⼦の散乱過程、散乱回数
Single scattering: 単散乱

ZnO

Scatteing path No.1 を平⾯図にすると･･･

O

O

O同じ距離にOが3つ
(距離がほぼ同じNo.2
を含めると４つ)

1.959 A

Znから⾶び出した光電⼦が
Oに1回だけ散乱されてGa
に戻ってくる（Single 
scattering）

e-

e-＠

2.040 A



[補⾜]他の散乱パスはどのように記述されているのか？

③ EXAFSの理論計算

一回散乱
(single scattering path)

二行程
(2 legs)

二回散乱
(doble scattering path)

三行程
(3 legs)

三回散乱
(triple scattering path)

四行程
(4 legs)

Zn

Zn

Zn_1 O_1

O_2

Zn_2

Artemisで計算されるR（距離）＝光電⼦が散乱された距離の ½
１回散乱の R = 結合距離
２回以上の散乱過程のRは、もはや結合距離ではないことに注意



③ EXAFSの理論計算
EXAFS 計算結果をグラフに表⽰する

表⽰したい散乱パス(No.1-7)を選択
(複数選択はCtrlを押しながら）

データウィンドウの
Path list 内に ドラッグ＆ドロップ

表⽰したい散乱パスを
左クリックで選択

このボタンを押すと、該当する
データがPlotting listに追加



③ EXAFSの理論計算
EXAFS 計算結果をグラフに表⽰する

それぞれの散乱パスを⾜し合わせたEXAFSを
表⽰したい場合は？

追加を確認！



それぞれの散乱パスを⾜し合わせたEXAFSを表⽰する

③ EXAFSの理論計算

⾜し合わせたいパスに☑を⼊れる



それぞれの散乱パスを⾜し合わせたEXAFSを表⽰する

③ EXAFSの理論計算

Actions > Make sum of marked paths and plot in R
or
Alt + Shift + m



③ EXAFSの理論計算
それぞれの散乱パスを⾜し合わせたEXAFSを表⽰する

名前をつける ＞OK



それぞれの散乱パスを⾜し合わせたEXAFSを表⽰する

③ EXAFSの理論計算

追加を確認！

タブが⾃動的にVpaths
に移動するが、◁▷ボタ
ン ＆ 他のタブをクリッ
クすれば移動できる

散乱パス⾜し合わせの注意点
F.T.(Zn-O(k))+F.T.(Zn-Zn(k)) ≠ F.T. (Zn-O(k)+Zn-Zn(k))

それぞれのEXAFS振動をF.T.して
から⾜す（間違い）

それぞれのEXAFS振動を⾜して
からF.T.する（こちらが正しい）



これまでのデータを保存する

③ EXAFSの理論計算

File > Save project as
or
Ctrl + s
or 
Save ボタン
→ Artemis-ZnO.fpj

Artemisには、未知のバグが多数存在するので
こまめに上書き保存することをおすすめします。
動作がおかしくなったら、保存してArtemisを
再⽴ち上げしてください。使い続けると突然
クラッシュします。

これまでに出会ったバグ（おそらくまだ修正されていない）
 フィッティングを⼀度も実⾏せずに保存し、Artemisを⽴ち下げると、

⼆度と⽴ち上がらなくなる。
 Data sets に実験データをインポートした後、削除し、もう⼀度同じ実験

データをインポートするとフィッティングする際にエラーを起こす。
*バグの出⽅はOSにも依存します。
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④ フィッティングパラメータの作成

フィッティングで求めるパラメータ
S0

2 （多体効果（定数））
rj （距離）
j (デバイワラー因⼦)
ΔE0 （kの原点）
※Nj （配位数）は固定

FEFFによる理論計算で求める
パラメータ
Fj(k)（後⽅散乱因⼦）
j(k) （位相因⼦）

Σj ： 散乱原子に対して足し合わせ
る
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EXAFS振動

＜EXAFSの基本式＞



④ フィッティングパラメータの作成

Artemis上での変数を定義する
S0

2 （多体効果（定数））→ amp
rj （距離）→ delr（*FEFFで計算したRからの変位のみを計算）
j (デバイワラー因⼦) → ss
ΔE0 （kの原点） → enot
※Nj （配位数）は固定 → N=4

まずは、第⼀配位圏のZn-O結合に対してフィッティングをかけてみる
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変数に使う⽂字は何でもよい（a,b,c,a1,b2…）が、プラス（+）、
ハイフン（-）、アスタリスク（*）、スラッシュ（/）を⼊れてしまうと、
演算の意味になってしまうので、変数には使わないようにしてください。



④ フィッティングパラメータの作成

Artemisに変数を登録する
S0

2 （多体効果）→ amp
rj （距離）→ delr
j (デバイワラー因⼦) → ss
ΔE0 （kの原点） → enot
※Nj （配位数）は固定 → N=4
（No.1とN.2は距離が近いため）

まずは、第⼀配位圏のZn-O結合に対してフィッティングをかけてみる
Zn-O.1結合を選択



④ フィッティングパラメータの作成
まずは、第⼀配位圏のZn-O結合に対してフィッティングをかけてみる

各パラメータの⼊⼒欄内で右クリックするとオプション
ウィンドウが出てくる
guess:

独⽴なパラメータ
def:

他のパラメータに依存するパラメータ
数式で定義、定数でも可

set:
定数
（数式でも定義可だが，フィッティング初期に計算後

は更新されない）
Skip:

フィッティングで考慮しないパラメータ



④ フィッティングパラメータの作成
まずは、第⼀配位圏のZn-O結合に対してフィッティングをかけてみる

Guessを選択



④ フィッティングパラメータの作成
まずは、第⼀配位圏のZn-O結合に対してフィッティングをかけてみる

Guessを選択

パラメータウィンドウが出てきて、登録が完了する

初期値 or 数式⼊⼒欄変数

パラメータの種類を選択



④ フィッティングパラメータの作成
まずは、第⼀配位圏のZn-O結合に対してフィッティングをかけてみる

全てのパラメータを登録する

× で消してしまっても ここを左クリックで復活します

これでフィッティングパラメータの作成は完了！！
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① Athenaデータ読み込み

② 構造モデルの作成(Atoms)
モデル作成に必要な情報
・吸収元素の種類、吸収端
・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）
・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実⾏

Athenaでデータ処理しておく！
・Background、Baselineの処理
・(k)(EXAFS振動)の抽出
・(k)をFT-EXAFSに変換

Atoms: FEFFの実⾏ファイルを
作成するためのプロフラム

.cif ファイルを⼊⼿しておくと
モデル作成の⼿間が幾分省ける

FEFF: 光電⼦の散乱過程と
散乱強度を計算するための

プログラム

⑦ 解析結果の保存

⑥ 束縛条件下でのフィッティング



⑤ フィッティング実⾏
まずは、第⼀配位圏のZn-O結合に対してフィッティングをかけてみる

Zn-O結合のみを切り出す（フィッティングの範囲）
rmaxを2に変更

3に☑

Include in fit, Plot after fitに☑

Include path, Plot after fitに☑
Zn-O.1結合を選択

フィッティングに⽤いる k の範囲を指定



⑤ フィッティング実⾏
まずは、第⼀配位圏のZn-O結合に対してフィッティングをかけてみる

Include path, Plot after fitのチェック
を外す（フィッティングから除外）

Zn-O.2結合を選択

以後の結合も同様に、include path, 
Plot after fitのチェックを外す
(結合表記が三重括弧になっている
ことを確認)



⑤ フィッティング実⾏
まずは、第⼀配位圏のZn-O結合に対してフィッティングをかけてみる

いよいよフィッティング！
その前に、保存！！

R を選択

フィッティングを実⾏



⑤ フィッティング実⾏
フィッティングが終了すると結果ウィンドウが出てくる

⾊＝フィッティングの良し悪し（緑＞⻩＞⾚ とフィッティ
ング結果が悪くなるにつれて連続的に⾊が変化する）
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フィッティング結果

*数値の⽬安
amp (S02): 0.70 - 1.10
enot (E, e0): < 10 eV
ss (2)     : 0.003 - 0.020 Å2



⑤ フィッティング実⾏
フィッティングの結果をグラフ上で⾒る

フィッティング結果をプロット



⑤ フィッティング実⾏
第⼆配位圏のZn-Zn結合も考慮したフィッティングをかけてみる

Zn-Zn.1結合を選択

Zn-Zn結合に関する変数を新たに作成・登録



⑤ フィッティング実⾏
第⼆配位圏のZn-Zn結合も考慮したフィッティングをかけてみる

Include path, Plot after fitに☑

Zn-Zn結合を含むようにフィッティングの範囲を拡⼤する
Rmaxを3.6に変更



⑤ フィッティング実⾏

いよいよフィッティング！
その前に、保存！！

第⼆配位圏のZn-Zn結合も考慮したフィッティングをかけてみる

R を選択

フィッティングを実⾏



⑤ フィッティング実⾏
フィッティングが終了すると結果ウィンドウが出てくる



⑤ フィッティング実⾏
フィッティングの結果をグラフ上で⾒る

フィッティング結果をプロット

この結果を .txt で保存したい時は？



⑤ フィッティング実⾏
フィッティングの結果を .txt で保存する

Save next plot to a file
を左クリックしてから

保存したいプロットを
選択



⑤ フィッティング実⾏
過去のフィッティングの結果を⾒る

History を左クリック

過去のフィッティング結果を選択

保存もできる



EXAFS解析の流れ
Artemis⽴ち上げ

① Athenaデータ読み込み

② 構造モデルの作成(Atoms)
モデル作成に必要な情報
・吸収元素の種類、吸収端
・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）
・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実⾏

Athenaでデータ処理しておく！
・Background、Baselineの処理
・(k)(EXAFS振動)の抽出
・(k)をFT-EXAFSに変換

Atoms: FEFFの実⾏ファイルを
作成するためのプロフラム

.cif ファイルを⼊⼿しておくと
モデル作成の⼿間が幾分省ける

FEFF: 光電⼦の散乱過程と
散乱強度を計算するための

プログラム

⑦ 解析結果の保存

⑥ 束縛条件下でのフィッティング



⑥ 束縛条件下でのフィッティング
変数に制限をかけてフィッティングをかけてみる

(case 1) Zn-O結合、Zn-Zn結合の距離を格⼦定数から算出し、定数として扱う
・FEFFでは、格⼦定数から距離 R を計算
・フィッティングでは R からの変位 Δr のみを最適化

Δ r (= delr) を guess から set パラメータに変更し、ʼʼ0ʼʼ として扱えばよい



⑥ 束縛条件下でのフィッティング
変数に制限をかけてフィッティングをかけてみる

(case 2) 結晶構造（対称性）から、Zn-Zn結合は、Zn-O結合の1.633倍⻑い
・FEFFでは、格⼦定数から距離 R を計算
・フィッティングでは R からの変位 Δr のみを最適化

R(Zn-Zn) = 1.633*R(Zn-O)
R(Zn-Zn) + Δ r (Zn-Zn) = 1.633*R(Zn-O)+ 1.633*Δ r (Zn-O)
→ Δ r (Zn-Zn) = 1.633*Δ r (Zn-O)

delr_2 を guess から def パラメータに変更し、ʼʼ1.633*delrʼʼ とすればよい



⑥ 束縛条件下でのフィッティング
変数に制限をかけてフィッティングをかけてみる

(case 3) amp を 0.8~1.0 の間に収まるようにフィッティングする。
Amp 上で右クリック→Build restraint from amp を選択



⑥ 束縛条件下でのフィッティング
変数に制限をかけてフィッティングをかけてみる

(case 3) amp を 0.8~1.0 の間に収まるようにフィッティングする。

数値の制限を指定するウィンドウが出てくる
Scale by : 1000 デフォルトのままで OK
Lower bound : 数値の下限
Upper bound : 数値の上限

Make restraint で確定する
制限パラメータ restrain が追加される



EXAFS解析の流れ
Artemis⽴ち上げ

① Athenaデータ読み込み

② 構造モデルの作成(Atoms)
モデル作成に必要な情報
・吸収元素の種類、吸収端
・結晶構造パラメータ（空間群、座標等）

③ EXAFSの理論計算（FEFF）
・Artemisに予め組み込まれている

④ フィッティングパラメータの作成

⑤ フィッティング実⾏

⑥ モデル妥当性の検証

Athenaでデータ処理しておく！
・Background、Baselineの処理
・(k)(EXAFS振動)の抽出
・(k)をFT-EXAFSに変換

Atoms: FEFFの実⾏ファイルを
作成するためのプロフラム

.cif ファイルを⼊⼿しておくと
モデル作成の⼿間が幾分省ける

FEFF: 光電⼦の散乱過程と
散乱強度を計算するための

プログラム

⑦ 解析結果の保存



⑦ 解析結果の保存

Save
Artemisのプロジェクトファイル保存

こまめに保存することをおすすめします



QFS（Quick-First-Shell Fit）
第１配位圏のみを解析するのに便利
Athenaからデータインポートするまでは同じ



QFS（Quick-First-Shell Fit）
第１配位圏のみを解析するのに便利
Athenaからのデータインポートするまでは同じ

Ga K-edge のデータ 第１配位圏は、Ga-N結合なので
N に変える

予想される結合距離に変更する
Zn-O の場合は、2.0 

フィッティングパラメータを⾃動的に作成し、登録する



QFS（Quick-First-Shell Fit）

パラメータを⾃動⽣成・登録
N（配位数）は⾃分で変える



Html版マニュアル
https://bruceravel.github.io/demeter/documents/Artemis/index.html

各種参考情報
http://xafs.org/Tutorials
特にShelly D. Kelly ⽒(Argonne Natl. Lab.) のAthenaとArtemisに関するtutorial

http://xafs.org/Tutorials?action=AttachFile&do=get&target=Basics_of_XAFS_to_chi.pdf
http://xafs.org/Tutorials?action=AttachFile&do=get&target=Basics_of_XAFS_analysis.pdf

Iffefitのメーリングリスト（Iffefit, Athena, Artemisの開発者から回答してもらえる）
http://millenia.cars.aps.anl.gov/mailman/listinfo/ifeffit/

メーリングリストのアーカイブ（過去に同様な質問がされていないかどうか確認しておく）
http://millenia.cars.aps.anl.gov/pipermail/ifeffit/

付録1：マニュアル・参考情報



● ICSD (Inroganic Crysta Structure Database)
http://icsd.ill.eu/icsd/index.php
無機化合物の結晶学データ等を収録
有料

● NIMS物質・材料データベース
http://mits.nims.go.jp/
ユーザー登録が必要(無料)

●The  Atoms.inp Archive
http://cars9.uchicago.edu/~newville/adb/search.html
WebAtomsとリンクし、feff.inpファイル
の取得が 可能

付録２：結晶構造データベース



付録３ atoms.inpをインターネット上で作成
WebAtoms
http://millenia.cars.aps.anl.gov/webatoms/

⽂献などから既知の結晶構造を⼊⼒
cifファイルの読み込みも可能

The  Atoms.inp Archive
からの⼊⼒も可能



付録４：モデルの三次元可視化による確認
(可視化プログラム利⽤)

プログラム起動

ここでは可視化プログラムの一つとしてVESTAを利用する。
(http://jp-minerals.org/vesta/jp/)

メニューから File －Open を選択


